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Monarch Printer Installation and Configuration Guide

The first three sections of this Monarch printer guide contain general information, and the

subsequent sections are for specific Monarch printer types and operating systems.

e Monarch Printers
e Label Types
e General Information
e Monarch 94XX Printer:
o Windows 2000 and Windows XP:

» Troubleshooting

= Install and Configure the Printer

= |Label Calibration/Print a Test Label
o Windows 7 and Windows 8:

= Install and Configure a Monarch 94XX Printer on Windows 7 and 8
Monarch 98XX Series Printer (Windows 2000, Windows XP, Windows 7, & Windows 8):

o Install and Configure a Monarch 98XX Series Printer

o Reset the Monarch 98XX Series Printer
e Monarch 94XX Printer (Windows 10):

o Install the Printer Driver

o Configure the Printer

o Configure and Test the Internet Explorer Connection

o Print a Test Label

Tips:

e Use this document in conjunction with your Monarch Reference Manual.
e For out of scope Monarch Label Printer Issues, we recommend that you call Paxar
customer support @ 1-800-543-6650 and talk to their helpdesk. They can perform

rigorous troubleshooting and dispatch a tech if needed.
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MONARCH PRINTERS

The following images will help you identify which type of Monarch printer you are using.

e 9416 Printer with Ink Ribbon:

e 9416 / 9416XL Thermal Printer:

e 98XX Series Printer:

Monarch
9800
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e 9419 Printer:

LABEL TYPES

There are four types of labels that are supported by KWI.

1
2.
3.
4

Small Sticky 1.2" x 1.1"
Large Sticky 2" x 1"
Rat Tail 3" x 1"

Hang Tag 1.5" x 2.75"
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Small Sticky: 1.2”x1.1”

dept # class # Color Name
Vendor Style

Size

Actual Size POS description (15 bytes)
barcode

sku

price

Large Sticky: 27x 12

dept # class # Color Name
Vendor Style
Size
Actual Size POS description (15 bytes)
barcode
sku
price
Rat Tail: 3”x1”
Open Folded
Actual Size
Actual Size

Client Name

POS description (15 bytes)

dept #/ class #

Price

Sku

Barcode
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Hang Tag: 1.5" x 2.75"

O O

Client Name

dept # class # Color Name
Actual Size Vendor Style

Size

POS description (15 bytes)
barcode

sku

price

GENERAL INFORMATION

Monarch printers:

e Must be installed as a Generic/Text Only printer.
e Use different types of labels (previously described here).

e Use a USB cable connection.
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MONARCH 94XX PRINTER (WINDOWS 2000 AND WINDOWS XP)

Notes:

e KWI recommends Internet Explorer (IE) 9 or below for the Monarch 94XX printer
e If you are installing/configuring a Monarch 94XX printer on Windows 10, go here

instead.

USB TROUBLESHOOTING
After reseating the USB cable and power cycling the printer, if Windows still does not detect
it, review the Windows Device Manager and look for any “"Unknown Devices” (as shown

below):

IE T M= B3
| acton vew ||+ = @ @[
-2 KWI-555Y5
= M Computer
= & Disk drives
= gmday adapters
% 74} DVD/CD-ROM drives
= 2 Floppy disk controllers.
9 Standard floppy disk controller
+ {34 Human Interface Devices quiry >>
% &3 IDE ATAJATAPI controllars
+ @8 Keyboards
% % Mce and other ponting devicas
& Madeams
+ @ monitees nqister Totals
# < Mubfunction adapters
+ W8 Network adapters This is most likely the USB device you are
e (:?a\'r?:‘-(::sy,w troubleshooting. This moy be a Monarch Label
4 Poets (COMBLPT) Printer, MC3000, or external printer ustomer Profile
4 €@ 5051 and RAID controlers
4 Scund, video and game controlers

hlock Register

. System devices
# G Untversal Serial Bus controllers tore Funcs >>
+ ‘Windows CE USE Devices

Register No. 001
[F7] Backoffi
Tranzaction No. 208028 (2l s ce

Version No. 5504534

Azsocide No.
Time 100833 AM -I MC3000 >>
Regster Cpen 0.00
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INTERNET EXPLORER TROUBLESHOOTING
o Verify that your IE settings have no header and footer

e Open IE and select File then Page Setup

/> Microsoft Windows Update - Windows Internet Explorer 1 _|D|}J
@T\_-) @ [ htp:/fwww.update.micr... ¥ | B[ $2 || X | [ Live search R~
File Edit ‘iew Favorites Tools Help

’I:::Ii:::t: o E::::l Sites v @ Free Hotmail € Web Slice Gallery » @ | tiki-index @ | KWI Wiki Log In

New Window Ctrl+h i © Y gs - Pagev Safety~ Toos+ @+

New Session S T

Onen Ctl+O Quick Lin| Home | Worldvide

Edit with Notepad arch Microsoft.com for:

Save ctrlts L~ Go|

o EET
trl-

Page Setup. [ # arketplace | Office Family | Microsoft Update
Print... ':trI+P :llt E = to Windows Update e B
L With Autor
5 can autome
=0 2 Get Microsoft security ups
Impart and Export... New! Go and install t
Update today!
Properties
Work Offiine Keep your computer up to date Junc
Exit Check to see if you need updates for Windows, your hardware or your
devices.
FAQ
e
Get help and support = Express ] Get high-priority updates 1) new -
4 ded)
Use administrator options | 4] | » |

‘Windows Update Privacy Statement

© 2013 Microsoft Corporation. Al rights reserved, Terms of Use | Trademarks

Changes paper, headers and footers, ofi ion, and margins For this page. Va v H100% v

Clear all headers and footers in Page Setup:
x
' [ReeSwan Mangra nches)
iy . Pe . o =
[Letter = %_ [Lottar 5" 5 11") EHE o
Source!  Porsat " Landscape To [675—- %—
[Arcmescay seloct K| %‘ I™ Pt Boch ground Cors s meges gy (75— @-

% Enstie StenksoFt

IE6 1IE7-11
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e On IE 9-11, make sure the pop-up blocker is disabled and Compatibility View

Settings are set. On the menu bar, click Tools > Pop-up Blocker > Turn off Pop-up

Blocker.

GG Help

Delete browsing history...
InPrivate Browsing

Turn on Tracking Protection
ActiveX Filtering

Fix connection problems...
Reopen last browsing session
Add site to Start menu

View downloads

Ctrl+Shift+Del
Ctrl+Shift+P

Ctrl+)

I Pop-up Blocker

v I Turn off Pop-up Blocker I

SmartScreen Filter

Manage add-ons

4 Pop-up Blocker settings

Click Tools > Compatibility View Settings. kligerweiss.net should be listed in the

large Compatibility View box. If it is not, type kligerweiss.net into the Add this
website field, click Add, and then click Close.

Delete browsing history.. Ctrls Shift+ Ded
InPrivate Browsing Ctrl+ Shift+P
Tuen on Tracking Protection

ActiveX Filtering

Fix connection problems

Reopen last browsing session

Add site to Start menu

View downloads Ctrls)
Pop-up Blocker »
SmartScreen Filter »
Manage add-ons

Compatibility View settings

3 be to this feed.
Feed discovery »
Windows Update
Performance dashboard
F12 Developer Tools

Ctrle Shifte U

Lync Click to Call

01/21/2019
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Add this website: }l

Hgerwess.net | Add

Websites you've added to Compatiity View:

7| Display intranet sites in Compatibiity View
¥ Use Mcarosoft compatbiity ksts
L by reading the joiamme?t Explorer privacy siatemsant

| e |

Add ths website:

Websites you've added to Compatbiity View:
Kigerwess.net

—

V| Display intranet sites in Compatiblity View
| Use Maosoft compatbiity ksts
Learn more by reading the [nternat Explorer privacy statement
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INSTALL AND CONFIGURE A MONARCH 94XX PRINTER

¢*e

1. Plug in the USB cable to the 94XX printer and to the back of the computer and an Add
Hardware Wizard should appear.
2. Select Install the hardware that I manually select from a list (Advanced) and click

Next.
Add Hardware Wizard

The wizard can help you install other hardware .

The wizard can search for other hardware and automatically install it for you, Or, if you
know exactly which hardware model pou want to install, you can select it from a list.

what do you want the wizard to do’?
" Search for and install the hardware automaticaly [Recommended)

< Back I Mext > I Cancel |

3. Click Next.
Add Hardware Wizard

From the list below. zelect the type of hardware you are installing .

IF pow do not zee the hardware category pou want, click Show All Devices.

Common hardware types:

FPCMCIlA and Flash memony devices :I
K Portable Devices

 Ports [COM & LPT)

‘ Printers

€& 5051 and RAID controllers
@, Sound, videa and game contrallers J
=

:* System devices
@A T ane drives

< Back I Hest » I Cancel |
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4. Install as a Generic/Text Only printer and save it. Click Next.

Add Hardware Wizard

Install Printer Software N
The manufacturer and model determine which printer software to uze.

W\ Select the manufacturer and model of your printer. If wour printer came with an installation
disk, click Hawe Dizk. [f pour printer iz not lizbed, conzult your printer docunmentation for
compatible printer software.

d

M anufacturer |~ I Frinters |~

Epson = % Ge y

EE::?EIM Eﬂ" Generic IBM Graphics 9pin

GLCC Eﬂ’ Generic |BM Graphics 9pin wide _

Generic : ;

v LI ?ﬂ’ k5 Publizher Color Printer d
This driver iz digitally signed. Windows Update | Have Disk... |

Tell me why driver signing is importarnt

< Back I Mest » I Cancel |

5. Click Next and specify Generic/Text Only or Monarch Label Printer for the Printer

name.

6. Click Next three more times.

Add Printer Wizard

Mame Your Printer
Y'ou must azsign a name ta this prinker.

Type a name for thiz printer. Because some programs do naot support printer and server
name combinations of more than 31 characters, it is best to keep the name as short ag
pozsible.

Frinter name:

Do pou want to use thiz printer as the default printer?

 Yes
f* No

< Back I Heut » I Cancel |

7. Click Next to complete the Printer Wizard.
8. Click the START button, then SETTINGS, then PRINTERS AND FAXES.
9. Right-click Generic/Text Only and select Properties.
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10. Right-click and select Properties:

File Edit View Favorites

Tools

=10 x|

Help

| &

QBack he J he 115

/'__j Search || Folders |v

Address IC‘,“, Printers and Faxes

EBE

-

Printer Tasks 3

[Z] add a printer

5l See what's printing

Select printing
preferences

é’ PaLse printing

i Share this printer

Iﬂn Rename this
printer

¥ Delete this printer

MName = | Docume. .. | Status

FHP LaserJet 551 MX o Ready

iz HP Laserlet 55i 0 Paper Jam
al n Offline

Set as Default Printer
Priniting Preferences...

Pause Printing

Sharing. ..
Use Printer Cnling

;{ Set printer
properties

Create Shortcut
Del=te
Rename

Other Places &

[ contral Panel

[ vI g I

-_-] Displays the properties of the selected items.

11. Click Advanced.

N A

21

& Generic / Text Only Printing Prefere

Layout | Paper/Quaiiy |

i~ Orientation
 Porral:
" | andscape

—Page Order
¢ Front to Back
{~ Back ta Front

Pages Per Sheet; I 1 - I

Advanced... |

Cancel |

[ o |

Apply |
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12. Change the Paper Size to US Std Fanfold and Advanced Printing Features to Disabled.
Generic / Text Only Advanced O 2| x|

;‘;ﬁ Generic / Text Only Advanced Document Settings
=Lk Paper fOutput

o Paper Size: US Std Fanfold
Copy Count: 1 Copy
=-fig Dacument Optians
(— Advanced Printing Features:

Disabled

QK. I Cancel |

13. Click on the Paper/Quality tab and change Paper Source to Cont. Feed — No Break.

Click OK and exit out of properties.
& Generic / Text Only Printing Prefere 2] x|

Lavout Faper/Qualiy |

Tray Selection
’7 Paper Source:

Advanced... |
0k I Cancel | Apply |
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14. Ask the client to test the label printer using client procedures in the KWI Back Office.
15. Under the Advanced tab, make sure you are using the Generic/Text Only drivers:
e Conenc / Teux Omly h:-c:«m .

wosty | Devce Semrgn Pt Commencs Fort Semcon
G Py Pota Adverced Comw Maragmomt
@ Llearys voriable

2 .
Aopdadie ipm

Prasty

Dwwgen Genanc / Tunt Only - Neg Dever

@ 1pooi perk documanes 10 program feaha protng faste
WRart pretng ey it page @ 1pooled

@ Yt preieyg premedutedy 1

LJ

Pomt deetly te the et

Hold mematiched documenta
¢ Prov spccied o wmrety font
Ketp proned Sodumerts

¢ Enabie adornced proteg lestrns

Protng Defaity Prgt Procesicr. Sepacatyr Page.

;' I

LABEL CALIBRATION/PRINT A TEST LABEL (MONARCH 9414/9416 ONLY)

To test the printer and calibrate it for the labels being used:

e Make sure the printer is off.
e Hold down the GREEN (9414)/GRAY (9416) feed button on top of the printer
e Turn the printer on.

e When the status light flashes RED/YELLOW one time, release the feed button.
The printer should advance labels slowly, then speed up and print out a test label.

The printer is now in data dump mode. Push the feed button again after the test label has
printed to take the printer out of data dump mode, or turn the printer off and back on to

return to normal operation.
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LABEL CALIBRATION/PRINT A TEST LABEL (MONARCH 9416XL ONLY)

To test the printer and calibrate it for the labels being used:

e Turn the printer off.

e Hold down the GRAY feed button.

e Turn the printer on.

e The status lights will blink — yellow (orange), green, yellow (orange), red (5 times),
yellow (orange)

e Let go of the feed button as soon as you see the third yellow (orange) light.

A few labels will be printed. Two of them should have a checker board pattern on the

bottom and the rest should be blank.

The printer is now in data dump mode. Push the feed button again after the test label has
printed to take the printer out of data dump mode, or turn the printer off and back on to

return to normal operation.

MONARCH 94XX PRINTER: INSTALL AND CONFIGURE ON WINDOWS 7 and
WINDOWS 8

Installing and configuring a Monarch 94XX label printer on Windows 7 & 8 is similar to
Windows 2000/XP (documented here). However, be aware of the following settings which

are specific to Windows 7 & 8:

e Driver: Generic/txt only (IF YOU SEE SEAGULL DRIVERS, CHANGE THEM BACK TO
GENERIC/TEXT)

e General tab > Click on Preferences > Click on the Paper/Quality tab

e Change the Paper Source to Cont Feed - No Break. Click on the Advanced button.

e Change the Paper Size to US Std Fanfold.

e Change the Advanced Settings to Disabled if the choice is there.

e Press Apply/OK three times to save all changes.
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MONARCH 98XX SERIES PRINTER (WINDOWS 2000, WINDOWS XP, WINDOWS 7,
and WINDOWS 8)

INSTALL AND CONFIGURE A MONARCH 98XX SERIES PRINTER
e Connection is typically via a physical USB cable

e Windows systems will sometimes need a COM port instead of USB port to print

RESET THE MONARCH 98XX SERIES PRINTER

Power the printer off. Hold the escape/clear button as you power on. You should get the

message Preparing for software load on the screen. Power the printer back off and back

on until you get to Print Mode Ready. This will reset the printer. After this is done you will

need to reset the printer.

e The printer will be at print mode ready when powered back up.

e Press the escape/clear button once and it will take you to Main Menu/Print Mode.

e Press the right arrow 4 times until you get to Main Menu Setup.

e Press Enter once and it will take you to setup/supply.

e Press Enter once and it will take you to supply/supply type.

e Press the right arrow once and it will take you to the ribbon.

e Press Enter once and it will either say ribbon yes or ribbon no. (Open the cover of
the printer and check if you have a ribbon installed)

e If you require no ribbon and wish to change it, press the left arrow for no and the

right arrow for yes (press Enter to save).

01/21/2019 Monarch Printer Installation and Configuration Guide
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e Press escape/clear once and it will take you to the supply/ribbon and press the left
arrow once and it will take you to supply/supply type.

e Press Enter once and it will display supply type/Die Cut or black Mark Check to see if
you are using labels with a black mark across the back of the labels. If there are no
black marks across the back of the label then you are using a die cut stock.

e Press the right arrow for black mark or left arrow for die cut depending on what
stock you are using.

e Press enter once and you will be at supply/supply type.

e Press escape/clear twice and it will display Main Menu/Print Mode.

e Press Enter once and it will take you back to print mode ready.

e Print your labels. To print a test label, on the front of the printer, press the left and

right arrows together for 2-3 seconds and then release them.
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MONARCH 94XX PRINTER (WINDOWS 10)
Perform the steps in the following sections before using your Monarch 94XX (i.e. 9419)

printer:

e Install the Printer Driver

e Configure the Printer

e Configure and Test the Internet Explorer Connection

e Print a Test Label

INSTALL THE PRINTER DRIVER

Note: Administrator access will be needed if the current user has certain restrictions

1. From the Start menu, search for Device Manager.

& Device Manager - m] X

File Action View Help
e m E Hm B

~ &% BSANDOVAL2-LAP
i Audio inputs and outputs
% Batteries
| Biometric devices
ﬂ Bluetooth
@ Cameras
= Computer
== Disk drives
@ Display adapters
! Firmware
@ Human Interface Devices
= Keyboards
0 Mice and other pointing devices
[ Monitors
P Network adapters
@ Ports (COM & LPT)
= Print queues
D Processors
07 security devices
lt Software components
B software devices
i} Sound, video and game controllers
S Storage controllers
K= System devices
i Universal Serial Bus controllers
' USB Connector Managers

2. Once you have Device Manager open, turn on your Monarch Printer.
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3. If Windows 10 has recognized the Monarch Printer, by default it should be placed
under “USB Printing Support”.

& Device Manager C 'Y
Fila  Action  View Help
| E n| =

I WA Miniport (L2TR) -
¥ WAl Miniport (Metwork Monitor)
I wian Miniport (FFROE)
I WA Miniport (FRTR)
I WAN Minipart (557TR)
W Pecs [cOM & LT
U Print queuss
O rrocessors
Bt Security devices
F* scfiveare companents
» B sofware devices
B Mimosoft Device dssociation Roct Enumarator
B Micoselt G5 Wavetable Synth
B Microsoft RRAS Foot Enumerator
B MOMARCH ncne16h KL

By Sound,vides and game controllers

S Storage mntrollers
i3 spstern devices
» B Universal Serial Bus controllers

§ Intal[R) USE 30 atansibla Host Contraller - 10 (Micmsoft)
§ FRealick USE 30 Card Reader
§ UsE Composite Devie
§ USE Frinting Support
§ USE Reot Hub (S8 30

§ USE Connector Managers =

Note: Due to slight Windows 10 variances/versions, you should also check under
"Software devices” or "Other Devices” to verify that the default Monarch printer was
installed.

4. Click Action > Add legacy hardware.

o Dweloe Marager a
File  Aglign View el

4= = Scan for hendwese changes

— Al legacy Bardmare -
Dievaces and Printers

Froperties

B O splary adagiers

. Femware

e Husvian teriecn Dossai

= Keyboands

W #tice and cther pointing devies

B Moniors

5 Matwork adapors

W Parts {00 B LFT)

= Print quess

O Frocmsons

B sty deviees

P softwas corrpenes

I Softwaee descor

& Sound.wideo end geme controlers

& Storage contralkes

B3 Syaem dievices

w § Unioeresl Senal Bus cantroliens

¥ inbelif) USE 10 etenshle Most Controller - 100 oosoft)
¥ Raalivk USS 10 Cand Roadar
§ USE Compeite Device
:' L58 Prnang Syppon
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5. Click Next.

Add Hardware

Welcome to the Add Hardware Wizard

This wazard helps you install gnver software to sugport older
dewices that do not support Mug-and-Hay and whidh are not
autamatcally recagnaed by Windows,

You should onfy use this wizard if you are an advanced user or
you have been directad here by tachnical support

a If your hardware came with an installation CD, it is
recommended that you click Cancel to close this wizard
and use the manufacturer's CD to install this hardware.

To contnue, click Nent

< Back Nose] > Cancal

6. Select Install the Hardware that I manually select from a list (Advanced) and click
Next.

Add Hardware

The wizard can help you install other hardware

The wizard can search for ather hardware and automatically install it for you. Or, if you knew
exactly which hardware model you want to install, you can select it from a list.

What do you want the wizard to do?
() Search for and install the hardware automatically (Recommended)

1® Install the hardware that | manually select from a list (Advanced)

<Back | MNext> | Cancel
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7. In the Common hardware types box, scroll through the list and choose Printers,

and then click Next.

Add Hardware

From the list below, select the type of hardware you ane installing

If you do not see the hardware category you want, dick Show All Devices.

Common hardware types:

= POS HID Magnetic Stripe Reader -
o POS Line Display

g POS Receipt Printer

F POS Remote Device

i Prommity devices
& Remote Desktop Cameara devices
@ 5BP2 IEEE 1394 devices

W 50 host adapters
LWy i s ilans

< Back Ned> | Cancel

8. On the Add printer screen, select the radio button Use an existing port, and then

select USBOOx (Virtual printer port for USB), where x is the USB port number into

which the Monarch printer is currently plugged.

hcle Deinter

Chocas o panter poet

A printer porsis g type of conneclion hat sl oas your torpater W echege infoome.ion with o printer.

*'Jse ar existing port LFT1: [Printer Port)
LPT1: (Frinter Port)
JCreale & new port: LPT2: (Printer Part)

LPT3: (Printer Port)

COM1: [S=rial Port)
CONM2: ‘Sarial Par)
COM3: ‘Sanal Part)
COM4: [Szrial Port)

FLE Print to Mik)

IR {Lozal Port)
PORT2ROMPT: {Local Port)

USEOD1 (Vitual parter oort for US8)

Vrluel Lucel Porl

Eack Naxt > Caneal

01/21/2019 Monarch Printer Installation and Configuration Guide
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9. When you get to the install the printer driver screen, on the left under
Manufacturer select Generic. On the right under Printers, select Generic/Text Only

and then click Next.

Add Printer

Install the printer driver

? Choose your printer from the list. Click Windows Update to see more models.
= _—

To install the driver from an installation CD, click Have Disk.

Manufacturer ~ || Printers @
EPSON 53 Generic / Text Only
Fuji Xerox & Generic Color XPS Class Driver (A)
Generic 4 Generic IBM Graphics 9pin
Gestetner 4 Generic IBM Graphics 9pin wide
HP i 4 Generic Mono XPS Class Driver (A) ¥
o This driver is digitally signed. Windows Update Have Disk..
Tell me why driver signing.is important

< Back Next > Cancel

10. Select Replace the current driver and click Next.

Add Printer

Which version of the driver do you want to use?

Windows detected that a driver is already installed for this printer.

O Use the driver that is currently installed (recommended)

® Replace the current driver
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11. Enter a name for your label printer and click Next.

Add Printes

Type a printer namea

Printer name: Generic / Text G'rllﬂ

This printer will be installed with the Generic / Test Only driver.

<Back | MNen=

Cancel
12. On the Printer Sharing screen, click Do not share this printer and then click Next.
Add Printer
Printer Sharing
If you want to share this printer, you must provide a share name. You can use the suggested name ar type
a new one, The share name will be visible to other network users.
* Do not share this printer
Share this printer so that others on your network can find and use it
< Back Mext = Cancel
01/21/2019
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13. Click Finish to save your changes and complete the installation.

—
Add Printer

You've successfully added Generic / Text Only

[T] Set as the default printer

To check if your printer is working properly, or to see troubleshooting information for the printer, print a
test page.

Print a test page

< Back Cancel

[\ 2

14. After the "Generic/Text only” driver has completed installing, go back to Device

Manager. The Monarch Printer should now be visible under Print queues.

A Device Manager — (] *
File Action View Help
o mECHEM B BXE

v % BSANDOVALZ-LAP ”

i Audio inputs and outputs

P Batteries

& Biometric devices

0 Bluetosth

@ Cameras

= Computer

== Disk drives

I Display adapters

i Firmware

Vi Human Interface Devices

— Keyboards

U Mice and other pointing devices

[ Monitors

B Network adapters

i@ Ports (COM &LPT)

= Print queues
= Wywinapp01\KWI_BEW - Konica Minclta C458
= Fax
= Generic / Text Only
= Microsoft Print to PDF
A Microsoft XPS Document Writer
= Root Print Queue

u Processors

B security devices

B software components

B software devices .

<
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CONFIGURE THE MONARCH 94XX PRINTER ON WINDOWS 10

1. On the Start menu, search for "Printers & scanners" and then click Printers &

scanners.
B ! 2 Filters
Best match

Printers & scanners
System settings

Can | help?
7?7 printers and scanners

Search suggestions

L printers and scanners - See web results >
£ printers and scanners queue

L printers and scanners list >
L printers and scanners setting p
jo printers and scanners windows 10 >
A printers and scanners in my pc >
L printers and scanners app

L printers and scanners mac os >

A2 printers and scanners
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VIMERCE: UNIFIED.

2. Select Generic / Text only (this name depends on what was entered previously).

Select Manage.

€4 Settings o
@ Home Printers & scanners
Find a setting Add printers & scanners
Devices. - Addaprinter o scanner
&§ Bluetooth & other devices
S Printers & scanners Printers & scanners
Fax
0O Mouse
B Touchpad Eg] Generic / Text Onlyl
& Typing
Open queue Manage Remove device

o Pen & Windows Ink

Eg] KWI_B&W - Konica Minolta C458 on nywinapp01
® AutoPlay o

3\ Microsoft Print to PDF

B us

Microsoft XPS Document Writer

3. On the left side of the Manage Your Device screen, click Printing preferences.

Manage your device

Printer status:  Idle
Open print queue

Print a test page

Run the troubleshooter

Printer properties

Printing preferences

Hardware properties

4. On the Printing Preferences screen, click the Paper/Quality tab, change the Paper

Source to Cont. Feed — No Break, and then click the Advanced button.

=
Layout PaperGuality
Tray Selection
Paper Source: Cont. Feed - No Break -
Advanced...
0K Cancel Aprly
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COMMERCE: UNIFIED.

5. Change the Paper Size to US Std Fanfold and disable Advanced Printing Features.

ed Options #

% Generic / Text Only Advanced Document Settings
=N= Paper/Output
Paper Size: US Std Fanfold
o (Copy Count: 1 Copy
F‘@ Document Options

Advanced Printing Features: | Wit s|=el v

OK Cancel

6. Press OK on the next two screens to save the changes.

CONFIGURE AND TEST THE IE CONNECTION WITH THE MONARCH 94XX PRINTER
1. Log in to the KWI Back Office website (http://www.Kligerweiss.net) and search/select

01/21/2019

Print Tickets.

Search
Print Ticksts 7

You ray choose Lo print tickets using one of the following selections. ...
Ordering = Tickeling = Print Tickels

Print Tickefs 7

Print Tickets Application: This pragram i uzed to print ticketa forall SKUs
that mateh the eglected crtesia. ... the Print Tickets application. ...
Ordering = Ticketing = Store Ticket Printing

v T
... The aility to print ficke ts va the booking screen. Please contact your Client
Senices Representative for detals or to set up any of these options. ..
‘Wamehouse = Receiving = Recaiving By ASN

Warehouse Receiving ™
e THCREE Printing, Select the type of boket you wanl to print. ulilize the dop down

bowes. Click on the print bution 1o print ticke ts ©or the PO, Results Data: ..
Warehouse = Receving = Warehmse Receiving

Reacaiing By Ewception 7

<. Option 1o default the "OTY Received” coluren to zer. Option to print tickets Wa
the booking screen. Cpfion o print the Accounts Payable Receiving Apran. ...
Warehouse = Receiving = Receiving By Exception

£l

Irventory Reporting & Analysts

This program is used lo print ickets for all SKUs that malch the selected criterda, ...

Print nrmdures a ointer fiendly wereion of the mood outout diselaved in the  calls

Store Menu

Firance Flarning CRM Security Test Menu
Resultz 1 - 10 of about 19 for print tickets =
What's New
sefections maiching

Q32818 Frinl Tickels 7

Adding a program fag optien te allaw
seanhing of @ 12 or 13 dgit barcode in
the SKUWUPC figd,

14/08M7 Print Ticketz 7

Adding a flag based option to enter 2 20
digit UCC-128 walue that will be parsed
to match the stored 14 digit value.

QBI3T

Receiving By ASH 7

By a program 1ag enable the skility to
print labels foritems receiving.

111516

The Scare Card report lets you view
suppart information {cals, ticksts, ste.)
for your company for the end of 3
selecied month.
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COMMERCE: UNIFIED.

2. If Java has not been installed it will ask you to install with a prompt that states Do
you want to run this application? Select Do not show this again for apps from

the publisher and location above and click Run.

Do you want to run this application?
2 Publisher: Kliger-Weiss InfoSystems Inc.
— Location: http://nfapbo03 Kllgerwelss.net

This application will run with unrestricted access which may put your
computer and personal information at risk. Run this application only if you
trust the location and publisher above.

(1{E

[0 nat show this again for apps from the publisher and location abave

“ More Information | Run ] Cencel

&

—_—

- = |
® lava ¢

& =
Once Java is installed the Ticket Printing screen is available.

Ordering Warehouse Reporting & Analysiz Store Menu CRM

| Ticket Printing

21 Setect & Label Formes
TICHET TVRE SELECT STORE
Made m Hat 1l (Frmter 342080 »  EHLOI-AUSTIN - |usrk:1n|lumnuml?nm vl

FRICING

A7 Print Tuckmtm iy

—— | osormmmons

e

& s sy P - ECEED
2 sTae e |

START DATE | EID DATE |

T PROMO RAME

o s annr | —

3 IMWENTOSY  VEHDOR &

«coLon S 4217700183 Cunnng: 2 Prce: 1
DDA =

-

[T S— —
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COMMERCE: UNIFIED.

3. Click the IE File menu, select Page Setup and under Headers and Footers; make

sure that all six boxes are set to -Empty- as illustrated below. When done, click OK.

Page Setup X
Paper Options Margins (inches)
Page Size: Left: 0.75
US Std Fanfold v Right [0.75
(®) Portrait (O Landscape Top 0.75
[_|Print Background Colors and Images Bottom: [0 75
Enable Shrink-to-Fit
Headers and Footers
Header Footer
-Empty- ~ | -Emply- v
-Emply- v | -Emply- v
-Emply- v -Emply- v
Change font
4. Click the IE Tools menu and select Compatibility View Settings. kligerweiss.net
should be listed in the large Compatibility View box. If it is not, type kligerweiss.net
into the Add this website field, click Add, and then click Close.
Compatibility View Settings X
l/_\h Change Compatibility View Settings
Add this website:
(| Add
Websites you've added to Compatibility View:
kligerweiss.net
Display intranet sites in Compatibility View
D Use Microsoft compatibility lists
Learn more by reading the Internet Explorer privacy statement
01/21/2019
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COMMERCE: UNIFIED.

5.
Add and then click Submit.

In the Ticket Printing application, select your Ticket Type, Store, and SKU/UPC

. Click

Ticket Printing

#1 Select a Label Format

TICKET TYPE SELECT STORE

o el
Made in Rat Tail (Printer 94XX) - | |56S001-AUSTIN

__#2 Print Tickets By

REF HUMBER

STORE RECEIVER &

TRANSFER #

® skuwpc | QUANTITY
ST

PROMO NAME

SHIP ORDER #

ENTORY WVENDOR #

..SKU:4217?00| 92 Quantity: 2 Price: -1

PRICING

| |Use RetailMarkdown Prices

| ORDER NUMBER
| WAREHOUSE RECEIVER &
ucc 128

| DISTRIBUTION ¥

PRICE

=
T

START DATE END DATE

Submit
6. The Print dialog box will open. Select Generic / Text Only (this name depends on
what was entered previously) and click Print.
= Print X
General Options

Select Printer

% Fax = Microsoft Print to

=g Generic / Text Only = Microsoft XPS Do

S KWI_B&W - Konica Minolta C458 on nywinapp01

< >
Status: Ready [ ]Printtofile  Preferences
Location:

Comment: Find Printer...
Page Range
® Al Number of copies: |1 5

Selection Current Page
() Pages: Collate
) ) 111 22l 33
Enter either a single page number or a
single page range. For example, 5-12
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COMMERCE: UNIFIED.

PRINT A TEST LABEL

On the Monarch 94XX (i.e. 9419) printer, there are two orange buttons with a larger orange

uon

directional key “+" between them.

1. Press the orange button on the left to display the menu.

2. Use the directional keys "+" until you see the Diagnostic option.
3. Select Diagnostic and press the right orange button.
4

Select Test Label to print a test label.

The following is a sample test label.:

MOoNna2arcn

0DEL :M0941902 F/W:Version 2.0
{AC Address: 00-1B-82-80-18-BE
IP Address : 000.000.000.000
JubNet : 000.000.000.000
IP GeteWay : 000.000.000.000
JHCP : Enabled

EEEEEEE
SN EREEREREP
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